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Package Contents

Note: Using a power supply  with a different voltage than the one included with the
DWL-AG700AP will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

Package Contents

� D-Link AirPlus    AG DWL-AG700AP
Wireless AG Access Point

� Power Supply - 5V DC 2.0A

� Manual on CD

� Quick Installation Guide

� Ethernet Cable

®

Minimum System Requirements

� Computers with Windows XP/2000, Macintosh, or Linux-based operating
systems with an installed Ethernet Adapter

� Internet Explorer version 6.0 or Netscape Navigator version 7.0 and above
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Introduction
Introduction

With a maximum wireless signal rate of up to 54Mbps*, the DWL-AG700AP is a wireless
access point that enables dualband networks, conveniently delivering connectivity in
both the 802.11a and 802.11g bands.

 With the DWL-AG700AP, bandwidth-intensive applications like graphics or multimedia
will benefit significantly because large files are able to move across the network quickly.

The D-Link AirPlus AG DWL-AG700AP provides maximum security with the option of
WPA or WEP. Additional security is provided with the optional use of filters for managing
network access.

With dualband capabilities, maximum wireless signal rates up to 54Mpbs, enhanced
security features including WPA and optional filter management, the DWL-AG700AP is
a versatile choice for your diverse network needs.

*Maximum wireless signal rate based on IEEE Standard 802.11a/g specifications. Actual data throughput will vary. Network
conditions and environmental factors lower actual data throughput rate.
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Connections

The Auto/MDIX LAN port automatically
senses the cable type when connecting
to Ethernet-enabled computers.

Pressing the Reset Button
restores the router to its original
factory default settings.

Receptor for the Power Adapter.
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LEDs

Power LED
A solid light indicates a proper
connection to the power supply.

WLAN LED
A solid light indicates that the wireless segment
(802.11a and/or 802.11b/g)  is ready. This LED blinks
during data transmission.

LOCAL NETWORK
LED
A solid light indicates
a connection (10M
and/or 100M) to an
Ethernet port. The
LEDs blink during
data transmission.
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Features and Benefits
Features and Benefits

*Maximum wireless signal rate based on IEEE Standard 802.11a/g specifications.  Actual data throughput will vary.

Better security with WPA-PSK - The DWL-AG700AP can securely connect to
wireless clients on the network using WPA-PSK providing a much higher level of
security for your data and communications than has previously been available.

�

Compatible with IEEE802.11a and IEEE802.11g standards to provide a wireless
data rate of up to 54Mbps.*

�

Backward compatible with the 802.11b standard to provide a wireless data rate
of up to 11Mbps with 802.11b devices - that means you can migrate your system to
the 802.11g standard on your own schedule without sacrificing connectivity.

�

Supports WEP encryption.�

Optional filter management feature - Access to your network can be controlled by
the MAC addresses of the devices, using the optional filter tool included in your
convenient Web-based management utility.

�
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Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless
networking brings.

A Wireless Local Area Network (WLAN) is a computer network that transmits and
receives data with radio signals instead of wires. WLANs are used increasingly in both
home and office environments, and public areas such as airports, coffee shops and
universities. Innovative ways to utilize WLAN technology are helping people to work
and communicate more efficiently. Increased mobility and the absence of cabling and
other fixed infrastructure have proven to be beneficial for many users.

People use WLAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs - WLANs are easy to set up, manage, change and relocate.
Networks that frequently change can benefit from WLANs ease of implementation.
WLANs can operate in locations where installation of wiring may be impractical.

Installation and Network Expansion - Installing a WLAN system can be fast and easy
and can eliminate the need to pull cable through walls and ceilings. Wireless technology
allows the network to go where wires cannot go - even outside the home or office.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices. The DWL-AG700AP saves money by providing
multi-functionality, configurable in one of four different modes.

Scalability - WLANs can be configured in a variety of ways to meet the needs of specific
applications and installations. Configurations are easily changed and range from Peer-
to-Peer networks suitable for a small number of users to larger Infrastructure networks
to accommodate hundreds or thousands of users, depending on the number of wireless
devices deployed.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.
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The D-Link  DWL-AG700AP lets you access your network, using a wireless connection,
from virtually anywhere within its operating range. Keep in mind, however, that the
number, thickness and location of walls, ceilings, or other objects that the wireless
signals must pass through, may limit the range. Typical ranges vary depending on the
types of materials and background RF (radio frequency) noise in your home or business.
The key to maximizing wireless range is to follow these basic guidelines:

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical devices or
appliances that generate RF noise.

4

Keep the number of walls and ceilings between the DWL-AG700AP and other
network devices  to a minimum - each wall or ceiling can reduce your DWL-AG700AP’s
range from 3-90 feet (1-30 meters.) Position your devices so that the number of walls or
ceilings is minimized.

1

Be aware of the direct line between network devices. A wall that is 1.5 feet thick
(.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter) thick. At a
2-degree angle it looks over 42 feet (14 meters) thick! Position devices so that the
signal will travel straight through a wall or ceiling (instead of at an angle) for better
reception.

2

Building materials can impede the wireless signal - a solid metal door or aluminum
studs may have a negative effect on range. Try to position wireless devices and
computers with wireless adapters so that the signal passes through drywall or open
doorways and not other materials.

3

Installation Considerations
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Getting Started

Consult with your Cable or DSL provider for proper installation of the modem.

Connect the Cable or DSL modem to a Router.
(See the printed Quick Installation Guide included with your router.)

Install a wireless AG adapter into computer 1.
(See the printed Quick Installation Guide included with the wireless AG
adapter.)

2

3

4

5

6

You will need broadband Internet access.11111

Connect the Router to the DWL-AG700AP.
(See the printed Quick Installation Guide included with the DWL-AG700AP.)

Install a wireless AG adapter into computer 2.
(See the printed Quick Installation Guide included with the wireless AG
adapter.)
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Using the Configuration Menu
Using the Configuration Menu

To configure the DWL-AG700AP, use a computer which is connected to the
DWL-AG700AP with an Ethernet cable.

First, disable the Access the Internet using a proxy server function. To disable
this function, go to Control Panel > Internet Options > Connections > LAN
Settings and uncheck the enable box.

Start your Web browser program (Internet Explorer, Netscape Navigator) .

Type the IP address of the DWL-AG700AP in the address field
(http://192.168.0.50) and press Enter. Make sure that the IP addresses of the
DWL-AG700AP and your computer are in the same subnet.

http://192.168.0.50

After the connection is established, you will see the user identification window as
shown.
Note: If you have changed the default IP address assigned to the DWL-AG700AP, make sure to
enter the correct IP address.

�

�

�

 Type admin in the User Name field

Leave the Password field blank

Click OK

Note: If you have changed the password, make sure to enter the correct password.
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Using the Configuration Menu

The Home>Wizard screen will appear. Please refer to the Quick Installation Guide for
more information regarding the Setup Wizard.

Home > Wizard

These buttons appear on most of the configuration screens in this section. Please click
on the appropriate button at the bottom of each screen after you have  made a configuration
change.
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Using the Configuration Menu

Home > Wireless

Service Set Identifier (SSID) is the name designated for a specific
wireless local area network (WLAN). The SSID’s factory default
setting is default. The SSID can be easily changed to connect to an
existing wireless network or to establish a new wireless network.

Enable or Disable SSID broadcast. Enabling this feature broadcasts
the SSID across the network.

52 is the default channel for the 802.11a wireless band. 6 is the
default channel for the 802.11g wireless band. All devices on the
network must share the same channel. (Note: The wireless adapters
will automatically scan and match the wireless setting.)

The radio frequency will vary depending on the wireless channel
that is chosen. The frequency in channel 52 is 5.26GHz.

SSID:

SSID Broadcast:

C h a n n e l :

Radio Frequency:

Wireless Band: IEEE802.11a is selected here. The other option is IEEE802.11g.
Choose the wireless band from the pulldown menu.
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Using the Configuration Menu

When you select WPA-PSK, choose a Cipher (EAP) type: AES, Auto
or TKIP.

Select Enabled or Disabled.

Select HEX or ASCII. Hexadecimal digits consist of the numbers
0-9 and the letters A-F. ASCII (American Standard Code for
Information Interchange) is a code for representing English letters
as numbers from 0-127.

Select 64-, 128-, 152-bit key size.

Select one key from the four keys that have been input.

Input up to four encryption keys here.

Click Apply to save the settings.

Cipher Type:

WEP Type:

Key Type:

Key Size:

Valid Key:

Keys 1-4:

Apply:

Authentication: Open System - Communicates the key across the network.
Shared Key - limits communication to only those devices that share
the same WEP settings.
WPA-PSK - increases the security level without a RADIUS server.
When you select WPA-PSK, you will need to enter a Passphrase
and select a Cipher (EAP) type.

Home > Wireless - continued
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Home > LAN

Static (Manual) is chosen here. Choose this option if you do not have
a DHCP server in your network, or if you wish to assign a static IP
address to the DWL-AG700AP.

The default IP address is 192.168.0.50. Assign a static IP address
that is within the IP address range of your network.

Enter the subnet mask. All devices in the network must share the
same subnet mask..

Enter the IP address of the gateway in your network. If there isn’t a
gateway in your network, please enter an IP address within the range
of your network.

Using the Configuration Menu

Get IP From:

IP Address:

Subnet Mask:

Default Gateway:

LAN is short for Local Area Network. This is considered your internal network. These
are the IP settings of the LAN interface for the DWL-AG700AP. These settings may be
referred to as private settings. You may change the LAN IP address if needed. The LAN
IP address is private to your internal network and cannot be seen on the Internet.



16

DWL-AG700AP User’s Manual

D-Link Systems, Inc.

Home > DHCP Server > Current IP Mapping

Using the Configuration Menu

These are IP address pools to which the DHCP server function has
assigned dynamic IP addresses.

Assigned
IP address-

Lease Time-

This screen displays information about the current DHCP dynamic and static IP address
pools. This information is available when you enable the DHCP function of the
DWL-AG700AP and assign dynamic and static IP address pools.

The MAC address of a device on the network that is within the DHCP
dynamic IP address pool.

The current corresponding DHCP-assigned  dynamic IP address of
the device.

The length of time that the dynamic IP address will be valid.

Current DHCP
Dynamic Pools-

Binding MAC
address-
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Using the Configuration Menu

Home > DHCP Server > Dynamic Pool Settings

Function Enable
or Disable:

IP Assigned From:

The Range of
Pool (1-256):

SubMask:

Gateway:

Wins:

Lease Time
(60-31536000 sec):

DNS:

Domain Name:

Status:

Enable or Disable the DHCP function here.

Enter the starting IP address in the range.

Enter the number (quantity) of IP addresses in the range.

Enter the subnet mask  here.

Enter the IP address of the router on the network.

Windows Internet Naming Service is a system that determines
the IP address of a network computer that has a dynamically
assigned IP address.

Enter the IP address of the DNS server. The DNS server translates
domain names such as www.dlink.com into IP addresses.

Enter the Domain Name of the DWL-AG700AP.

The Lease Time is the period of time before the DHCP server will
assign new IP addresses.

Turn the Dynamic Pool Settings ON or OFF here.
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Using the Configuration Menu

Advanced > Performance

Wireless Band:

Beacon Interval:

RTS Length
(256-2346):

Fragment Length:

DTIM (1-255):

Transmit Power:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is selected here.

Beacons are packets sent by an access point to synchronize a
network. Specify a beacon interval value. The default (100) is
recommended.

This value should remain at its default setting of 2346. If you
encounter inconsistent data flow, only minor modifications to the
value range between 256 and 2346 are recommended.

The fragmentation threshold, which is specified in bytes, determines
whether packets will be fragmented. Packets exceeding the 2346
byte setting will be fragmented before transmission. 2346 is the
default setting.

(Delivery Traffic Indication Message) - Select  a setting between 1and
255. 1 is the default setting. DTIM is a countdown informing clients of
the next window for listening to broadcast and multicast messages.

Choose full, half (-3dB), quarter (-6dB), eighth (-9dB), minimum
power.

Auto
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Using the Configuration Menu

Data Rate:

Radio Wave: Select ON or OFF.

The Data Rates are Auto, 1Mbps, 2Mbps, 5.5Mbps, 6Mbps, 9Mbps,
11Mbps, 12Mbps, 18Mbps, 24Mbps, 36Mbps, 48Mbps, 54Mbps.
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Using the Configuration Menu

Wireless Band:

Access Control:

MAC Address:

MAC Address List:

Select IEEE802.11a or IEEE802.11g. IEEE802.11a is chosen here.

Enter the MAC addresses that you wish to include in your filters list,
and click Save.

When you enter a MAC address, it appears in this list. Highlight a
MAC address and click Delete to remove it from the list.

Advanced > Filters > Wireless Access Settings

Select Disabled to disable the filters function.
Select Accept to accept only those devices with MAC addresses in
the Access Control List.
Select Reject to reject the devices with MAC addresses in the Access
Control List.
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Using the Configuration Menu

Tools > Admin

User Name:

Old Password:

New Password:

Confirm New
Password:

Enter a user name. The default setting is admin.

To change your password, enter the old password here.

Enter your new password here.

Enter your new password again.
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Using the Configuration Menu

Tools > System

Apply Settings and
Restart:

Restore to Factory
Default Settings:

Click Restart to apply the system settings and restart the
DWL-AG700AP.

Click Restore to return the DWL-AG700AP to its factory default
settings..
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Using the Configuration Menu

Tools > Firmware

Update File: After you have downloaded the most recent version of the firmware
from http://support.dlink.com to your hard drive, you can Browse
your hard drive to locate the downloaded file. Select the file and
click OK  to update the firmware.

1.001.001.001.001.00
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Using the Configuration Menu

Tools > Cfg File

Update File:

Load Settings to the
Loacl Hard Drive:

Browse for the configuration settings that you have saved to your
hard drive. Click OK after you have selected the settings file.

Click OK to save the selected settings to your hard drive.
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Tools > Cfg File > Choose file

When you click Browse in the previous screen, the dialog box shown above appears.
Select the file you wish to download and click Open.

When this dialog box appears, click Save and select a location to save the configuration
file.

Using the Configuration Menu
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Status > Device Info

Using the Configuration Menu

Device
Information:

This window displays the settings of the DWL-AG700AP, the
firmware version and the MAC address.

1.00

Auto

Auto
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Status > Stats

Using the Configuration Menu

WLAN 802.11A
Traffic Statistics:

Choose WLAN 802.11a Traffic Statistics, or choose WLAN 802.11g
Traffic Statistics. WLAN 802.11a is chosen here.
This window displays the statistics of the IEEE802.11a or
IEEE802.11g network, depending upon your selection.
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Status > Client Info

Using the Configuration Menu

The following information is available for each client that is communicating with the
DWL-AG700AP.

MAC:

BSSID:

Authentication:

Signal:

Power Saving
Mode:

Displays the MAC address of the client.

Basic Service Set Identifier is a name for a wireless network.

Displays the type of authentication that is enabled.

Receive Signal Strength Indicator indicates the strength of the signal

Displays the status of the power saving feature.
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Help

Using the Configuration Menu

Click on any item in the Help screen for more information.Help:
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Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using Microsoft
Windows XP.

Note:  Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000  for information about networking computers
using Windows 2000.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Networking Basics

When this screen appears, click Next.
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Networking Basics

Click Next.

In the following window, select the best description of your computer. If your computer
connects to the internet through a gateway/router, select the second option as shown.

Click Next.

Please follow all the instructions in this window:
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Networking Basics

Enter a Computer description and a Computer name (optional).

Click Next.

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Click Next.
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Please wait while the Network Setup Wizard applies the changes.

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer. This may take a
few minutes.

Networking Basics
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Networking Basics

Insert a disk into the Floppy Disk Drive, in this case drive A.

Click Next.

In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected.  You will run this disk on each of the computers
on your network. Click Next.
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Please read the information under Here’s how in the screen below. After you complete
the Network Setup Wizard you will use the Network Setup Disk to run the Network
Setup Wizard once on each of the computers on your network. To continue click Next.

Networking Basics
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Please read the information on this screen, then click Finish to complete the Network
Setup Wizard.

The new settings will take effect when you restart the computer. Click Yes to restart the
computer.

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network
Setup Disk on all your computers, your new wireless network will be ready to use.

Networking Basics
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Networking Basics

Naming Your Computer

To name your computer on Windows XP, please follow these directions.

� Click Start (in the lower left corner of the screen).

� Right-click on My Computer.

� Select Properties and click.

� Select the Computer Name Tab in the System Properties window.

� You may enter a Computer Description if you wish; this field is optional.

� To rename the computer and join a domain, Click Change.
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� In this window, enter the Computer name.

� Select Workgroup and enter the name of the Workgroup.

� All computers on your network must have the same Workgroup name.

� Click OK.

Networking Basics

The wireless adapter-equipped computers in your network must be in the same IP
Address range (see Getting Started in this manual for a definition of IP Address Range.)
To check on the IP Address of the adapter, please do the following:

� Right-click on the Local Area Connection icon in the task bar.

� Click on Status.

Checking the IP Address in Windows XP
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Networking Basics

This window will appear:

� Click the Support tab.

� Click Close.
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Note: DHCP-enabled routers will automatically assign IP addresses to the computers
on the network, using DHCP (Dynamic Host Configuration Protocol) technology. If you
are using a DHCP-capable router you will not need to assign static IP addresses.

If you are not using a DHCP capable router, or you need to assign a static IP address,
please follow these instructions:

� Go to Start.

� Double-click on Control Panel.

Assigning a Static IP Address in Windows XP/2000

Networking Basics

� Double-click on Network Connections.
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Networking Basics

� Right-click on Local Area Connections.

� Double-click on Properties.

� Click on Internet Protocol (TCP/IP).

� Click Properties.

� Input your IP address and subnet mask. (The IP addresses on your network must
be within the same range. For example, if one computer has an IP address of
192.168.0.2, the other computers should have IP addresses that are sequential,
like 192.168.0.3 and 192.168.0.4. The subnet mask must be the same for all the
computers on the network.)
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Networking Basics

� Input your DNS server addresses. (Note:  If you are entering a DNS server, you
must enter the IP address of the default gateway.)

The DNS server information will be supplied by your ISP (Internet Service Provider.)

� Click OK.

Assigning a Static IP Address in Macintosh OSX

� Go to the Apple Menu and select System Preferences.

� Click on Network.
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Networking Basics

� Select Built-in Ethernet in the Show pull-down menu.

� Select Manually in the Configure pull-down menu.

� Input the Static IP Address, the Subnet Mask and the Router IP Address in the
appropriate fields.

� Click Apply Now.
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Networking Basics

� Go to the Apple Menu and select System Preferences.

� Click on Network.

� Select Built-in Ethernet in the Show pull-down menu.

� Select Using DHCP in the Configure pull-down menu.
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Networking Basics

� Click Apply Now.

� The IP Address, Subnet mask, and the Router’s IP Address will appear in a few
seconds.

Go to Start > Run > type cmd.  A window similar to this one will appear. Type ping
xxx.xxx.xxx.xxx, where xxx is the IP address of the wireless router or access point. A
good wireless connection will show four replies from the wireless router or access point,
as shown.

Checking the Wireless Connection by Pinging
in Windows XP and 2000
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Troubleshooting

Troubleshooting
This chapter provides solutions to problems that can occur during the installation and
operation of the DWL-AG700AP Wireless Access Point. We cover various aspects of
the network setup, including the network adapters. Please read the following if you are
having problems.

Note:  It is recommended that you use an Ethernet connection to configure the
DWL-AG700AP Wireless Access Point.

1. The computer used to configure the DWL-AG700AP cannot access the
configuration menu.

� Check that the Ethernet LED on the DWL-AG700AP is ON. If the LED is not ON,
check that the cable for the Ethernet connection is securely inserted.

� Check that the Ethernet adapter is working properly.  Please see item 3 (Check that
the drivers for the network adapters are installed properly) in this
Troubleshooting section to check that the drivers are loaded properly.

� Check that the IP address is in the same range and subnet as the DWL-AG700AP.
Please see Checking the IP Address in Windows XP in the Networking Basics
section of this manual.

Note:  The IP address of the DWL-AG700AP is 192.168.0.50. All the computers on the
network must have a unique IP address in the same range, e.g., 192.168.0.x. Any
computers that have identical IP addresses will not be visible on the network. They
must all have the same subnet mask, e.g., 255.255.255.0.

� Do a Ping test to make sure that the DWL-AG700AP is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.50.  A successful ping will show
four replies.

Note: If you have changed the default IP address, make sure to ping the correct IP
address assigned to the DWL-AG700AP.
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Troubleshooting

2. The wireless client cannot access the Internet in the Infrastructure mode.

Make sure the wireless client is associated and joined with the correct access point. To
check this connection:  Right-click on the Local Area Connection icon in the taskbar>
select View Available Wireless Networks. The Connect to Wireless Network screen
will appear. Please make sure you have selected the correct available network, as
shown in the illustrations below.

� Check that the IP address assigned to the wireless adapter is within the same IP
address range as the access point and gateway. Since the DWL-AG700AP has an
IP address of 192.168.0.50, wireless adapters must have an IP address in the same
range, e.g., 192.168.0.x.  Each device must have a unique IP address; no two devices
may have the same IP address. The subnet mask must be the same for all the
computers on the network.) To check the IP address assigned to the wireless
adapter, double-click on the Local Area Connection icon in the taskbar > select
the Support tab and the IP address will be displayed. Please refer to Checking
the IP Address in the Networking Basics section of this manual.)

� If it is necessary to assign a Static IP Address to the wireless adapter, please refer
to the appropriate section in Networking Basics. If you are entering a DNS Server
address you must also enter the Default Gateway Address. (Remember that if
you have a DHCP-capable router, you will not need to assign a static IP address.
See  Networking Basics: Assigning a Static IP Address.)
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3.  Check that the drivers for the network adapters are installed properly.

You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are
using.

� Go to Start > My Computer > Properties.

Troubleshooting

� Select the Hardware Tab.

� Click Device Manager.
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Troubleshooting

� Double-click on Network Adapters.

� Right-click on D-Link AirPlus Xtreme G DWL-G650 Wireless Cardbus Adapter.
(In this example we use the DWL-G650; you may be using other network adapters,
but the procedure will remain the same.)

� Select Properties to check that the drivers are installed properly.

� Look under Device Status to check that the device is working properly.

� Click OK.
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Troubleshooting

4.  What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this
manual for further information about the most advantageous placement of your D-Link
wireless products.

5.  Why does my wireless connection keep dropping?

� Antenna Orientation- Try different antenna orientations for the DWL-AG700AP. Try to
keep the antenna at least 6 inches away from the wall or other objects.

� If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramatically
or drop altogether. Try changing the channel on your router, access point and wireless
adapter to a different channel to avoid interference.

� Keep your product away (at least 3-6 feet) from electrical devices that generate RF
noise, like microwaves, monitors, electric motors, etc.

6.  Why can’t I get a wireless connection?

If you have enabled encryption on the DWL-AG700AP, you must also enable encryption
on all wireless clients in order to establish a wireless connection.

� Make sure that the SSID on the router and the wireless client are exactly the same.
If they are not, wireless connection will not be established.

� Move the DWL-AG700AP and the wireless client into the same room and then test
the wireless connection.

� Disable all security settings.

� Turn off your DWL-AG700AP and the client. Turn the DWL-AG700AP back on again,
and then turn on the client.

� Make sure that all devices are set to Infrastructure mode.

� Check that the LED indicators are indicating normal activity. If not, check that the AC
power and Ethernet cables are firmly connected.

� Check that the IP address, subnet mask, gateway and DNS settings are correctly
entered for the network.

� If you are using 2.4GHz cordless phones, X-10 equipment or other home security
systems, ceiling fans, and lights, your wireless connection will degrade dramatically
or drop altogether. Try changing the  channel on your DWL-AG700AP, and on all the
devices in your network to avoid interference.

� Keep your product away (at least 3-6 feet) from electrical devices that generate RF
noise, like microwaves, monitors, electric motors, etc.
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7.  I forgot my encryption key.

� Reset the DWL-AG700AP to its factory default settings and restore the other devices
on your network to their default settings. You may do this by pressing the Reset
button on the back of the unit. You will lose the current configuration settings.

Troubleshooting
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Technical Specifications

Technical Specifications
Standards
• IEEE 802.11a
• IEEE 802.11b
• IEEE 802.11g
• IEEE 802.3
• IEEE 802.3u
• IEEE 802.3x

Device Management
• Web-Based – Internet Explorer v6 or later; Netscape Navigator v6 or later; or other
Java-enabled browsers.

Security
• 64-, 128-, 152-bit WEP
• WPA – Personal
• MAC Address Access Control List

Wireless Frequency Range
• 2.4GHz to 2.4835GHz
• 5.15GHz to 5.35GHz and
  5.725GHz to 5.825GHz

Radio and Modulation Type
For 802.11b:
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps
For 802.11a/g:
OFDM:
• BPSK @ 6 and 9Mbps
• QPSK @ 12 and 18Mbps
• 16QAM @ 24 and 36Mbps
• 64QAM @ 48, 54 and 108Mbps
DSSS:
• DBPSK @ 1Mbps
• DQPSK @ 2Mbps
• CCK @ 5.5 and 11Mbps

* Environmental Factors may Adversely Affect Wireless Range



53

DWL-AG700AP User’s Manual

D-Link Systems, Inc.

Technical Specifications

Receiver Sensitivity
For 802.11a:
• 6Mbps: -87dBm
• 9Mbps: -86dBm
• 12Mbps: -85dBm
• 18Mbps: -83dBm
• 24Mbps: -80dBm
• 36Mbps: -76dBm
• 48Mbps: -71dBm
• 54Mbps: -71dBm

For 802.11b:
• 1Mbps: -92dBm
• 2Mbps: -89dBm
• 5.5Mbps: -88dBm
• 11Mbps: -83dBm

For 802.11g:
• 1Mbps: -95dBm
• 2Mbps: -91dBm
• 5.5Mbps: -89dBm
• 6Mbps: -87dBm
• 9Mbps: -86dBm
• 12Mbps: -85dBm
• 18Mbps: -83dBm
• 24Mbps: -80dBm
• 36Mbps: -76dBm
• 48Mbps: -71dBm
• 54Mbps: -66dBm

Transmit Output Power
For 802.11a:
• 63mW (18dBm)
• 40mW (16dBm)
• 32mW (15dBm)
• 6mW (7dBm)
• 1mW (0dBm)
For 802.11b:
• 63mW (18dBm)
• 40mW (16dBm)
• 32mW (15dBm)
• 23mW (13dBm)
• 10mW (10dBm)
• 6mW (7dBm)
• 1mW (0dBm)
For 802.11g:
• 63mW (18dBm)
• 40mW (16dBm)
• 32mW (15dBm)
• 6mW (7dBm)
• 1mW (0dBm)
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Wireless Operating Range*
802.11a/g (Full Power with 2.0dBi gain diversity dipole antenna)
Indoor:
• 98ft (30m) @ 54Mbps
• 105ft (32m) @ 48Mbps
• 121ft (37m) @ 36Mbps
• 148ft (45m) @ 24Mbps
• 197ft (60m) @ 18Mbps
• 223ft (68m) @ 12Mbps
• 253ft (77m) @ 9Mbps
• 2951ft (90m) @ 6Mbps
Outdoor:
• 312ft (95m) @ 54Mbps
• 951ft (290m) @ 18Mbps
• 1,378ft (420m) @ 6Mbps

Antenna Type
• 2dBi Dualband Detachable Dipole Antenna

LEDs
• Power
• 10M
• 100M
• 802.11a
• 802.11b/g

Operating Voltage
• 5VDC +/- 10%

Temperature
• Operating: 32ºF to 104ºF (0ºC to 40ºC)
• Storing: -4ºF to 149ºF (-20ºC to 65ºC)

Humidity
• Operating: 10%~90% (non-condensing)
• Storing: 5%~95% (non-condensing)

Certifications
• FCC Part 15
• Wi-Fi

Dimensions
• L = 5.59 inches (142mm)
• W = 4.29 inches (109mm)
• H = 1.22 inches (31mm)

Weight
• 0.44 lbs (200g)

Warranty
• 1 Year
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Contacting Technical Support

You can find  software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and within
Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours/ 7 days a week
D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 7:30am to 12:00am EST
D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
·  Serial number of the unit
·  Model number or product name
·  Software type and version number

Contacting Technical Support
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Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited Warranty:

· Only to the person or entity that originally purchased the product from D-Link or its authorized reseller or distributor, and
· Only for products purchased and delivered within the fifty states of the United States, the District of Columbia, U.S.

Possessions or Protectorates, U.S. Military Installations, or addresses with an APO or FPO.

Limited Warranty:  D-Link warrants that the hardware portion of the D-Link product described below (“Hardware”) will be
free from material defects in workmanship and materials under normal use from the date of original retail purchase of the
product, for the period set forth below (“Warranty Period”), except as otherwise stated herein.

· Hardware (excluding power supplies and fans): One (1) year
· Power supplies and fans: One (1) year
· Spare parts and spare kits: Ninety (90) days

The customer’s sole and exclusive remedy and the entire liability of D-Link and its suppliers under this Limited Warranty will
be, at D-Link’s option, to repair or replace the defective Hardware during the Warranty Period at no charge to the original
owner or to refund the actual purchase price paid.  Any repair or replacement will be rendered by D-Link at an Authorized D-
Link Service Office.  The replacement hardware need not be new or have an identical make, model or part.  D-Link may, at
its option, replace the defective Hardware or any part thereof with any reconditioned product that D-Link reasonably
determines is substantially equivalent (or superior) in all material respects to the defective Hardware.  Repaired or replacement
hardware will be warranted for the remainder of the original Warranty Period or ninety (90) days, whichever is longer, and is
subject to the same limitations and exclusions.  If a material defect is incapable of correction, or if D-Link determines that it
is not practical to repair or replace the defective Hardware, the actual price paid by the original purchaser for the defective
Hardware will be refunded by D-Link upon return to D-Link of the defective Hardware.  All Hardware or part thereof that is
replaced by D-Link, or for which the purchase price is refunded, shall become the property of D-Link upon replacement or
refund.

Limited Software Warranty:  D-Link warrants that the software portion of the product (“Software”) will substantially conform
to D-Link’s then current functional specifications for the Software, as set forth in the applicable documentation, from the date
of original retail purchase of the Software for a period of ninety (90) days (“Software Warranty Period”), provided that the
Software is properly installed on approved hardware and operated as contemplated in its documentation. D-Link further
warrants that, during the Software Warranty Period, the magnetic media on which D-Link delivers the Software will be free of
physical defects.  The customer’s sole and exclusive remedy and the entire liability of D-Link and its suppliers under this
Limited Warranty will be, at D-Link’s option, to replace the non-conforming Software (or defective media) with software that
substantially conforms to D-Link’s functional specifications for the Software or to refund the portion of the actual purchase
price paid that is attributable to the Software.  Except as otherwise agreed by D-Link in writing, the replacement Software is
provided only to the original licensee, and is subject to the terms and conditions of the license granted by D-Link for the
Software.  Replacement Software will be warranted for the remainder of the original Warranty Period and is subject to the
same limitations and exclusions.  If a material non-conformance is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to replace the non-conforming Software, the price paid by the original licensee for the non-
conforming Software will be refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first
returned to D-Link.  The license granted respecting any Software for which a refund is given automatically terminates.

Non-Applicability of Warranty:  The Limited Warranty provided hereunder for Hardware and Software portions of D-Link’s
products will not be applied to and does not cover any refurbished product and any product purchased through the inventory
clearance or liquidation sale or other sales in which D-Link, the sellers, or the liquidators expressly disclaim their warranty
obligation pertaining to the product and in that case, the product is being sold “As-Is” without any warranty whatsoever
including, without limitation, the Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim:  The customer shall return the product to the original purchase point based on its return policy.  In case
the return policy period has expired and the product is within warranty, the customer shall submit a claim to D-Link as outlined
below:

· The customer must submit with the product as part of the claim a written description of the Hardware defect or Software
nonconformance in sufficient detail to allow D-Link to confirm the same, along with proof of purchase of the product
(such as a copy of the dated purchase invoice for the product) if the product is not registered.

· The customer must obtain a Case ID Number from D-Link Technical Support at 1-877-453-5465, who will attempt to
assist the customer in resolving any suspected defects with the product.  If the product is considered defective, the
customer must obtain a Return Material Authorization (“RMA”) number by completing the RMA form and entering the
assigned Case ID Number at https://rma.dlink.com/.

· After an RMA number is issued, the defective product must be packaged securely in the original or other suitable
shipping package to ensure that it will not be damaged in transit, and the RMA number must be prominently marked on
the outside of the package.  Do not include any manuals or accessories in the shipping package.  D-Link will only replace
the defective portion of the product and will not ship back any accessories.

· The customer is responsible for all in-bound shipping charges to D-Link.  No Cash on Delivery (“COD”) is allowed.
Products sent COD will either be rejected by D-Link or become the property of D-Link.  Products shall be fully insured
by the customer and shipped to D-Link Systems, Inc., 17595 Mt. Herrmann, Fountain Valley, CA 92708.  D-Link will
not be held responsible for any packages that are lost in transit to D-Link.  The repaired or replaced packages will be
shipped to the customer via UPS Ground or any common carrier selected by D-Link.  Return shipping charges shall be
prepaid by D-Link if you use an address in the United States, otherwise we will ship the product to you freight collect.
Expedited shipping is available upon request and provided shipping charges are prepaid by the customer.

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the foregoing requirements,
or for which an RMA number is not visible from the outside of the package. The product owner agrees to pay D-Link’s reasonable

Warranty
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handling and return shipping charges for any product that is not packaged and shipped in accordance with the foregoing
requirements, or that is determined by D-Link not to be defective or non-conforming.

What Is Not Covered: The Limited Warranty provided herein by D-Link does not cover: Products that, in D-Link’s judgment,
have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse, faulty installation, lack of
reasonable care, repair or service in any way that is not contemplated in the documentation for the product, or if the model or
serial number has been altered, tampered with, defaced or removed; Initial installation, installation and removal of the product for
repair, and shipping costs; Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;  Any hardware,
software, firmware or other products or services provided  by anyone other than D-Link; and Products that have been
purchased from inventory clearance or liquidation sales or other sales in which D-Link, the sellers, or the liquidators expressly
disclaim their warranty obligation pertaining to the product.  While necessary maintenance or repairs on your Product can be
performed by any company, we recommend that you use only an Authorized D-Link Service Office. Improper or incorrectly
performed maintenance or repair voids this Limited Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE PRODUCT IS PROVIDED
“AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING, WITHOUT LIMITATION, ANY WARRANTY
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY
CANNOT BE DISCLAIMED IN ANY TERRITORY WHERE A PRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED
WARRANTY SHALL BE LIMITED TO THE DURATION OF THE APPLICABLE WARRANTY PERIOD SET FORTH ABOVE.
EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED HEREIN, THE ENTIRE RISK AS TO
THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS WITH THE PURCHASER OF THE PRODUCT.

Limitation of Liability: TO THE MAXIMUM EXTENT PERMITTED BY LAW, D-LINK IS NOT LIABLE UNDER ANY CONTRACT,
NEGLIGENCE, STRICT LIABILITY OR OTHER LEGAL OR EQUITABLE THEORY FOR ANY LOSS OF USE OF THE
PRODUCT, INCONVENIENCE OR DAMAGES OF ANY CHARACTER, WHETHER DIRECT, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF GOODWILL, LOSS OF REVENUE OR
PROFIT, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, FAILURE OF OTHER EQUIPMENT OR
COMPUTER PROGRAMS TO WHICH D-LINK’S PRODUCT IS CONNECTED WITH, LOSS OF INFORMATION OR DATA
CONTAINED IN, STORED ON, OR INTEGRATED WITH ANY PRODUCT RETURNED TO D-LINK FOR WARRANTY SERVICE)
RESULTING FROM THE USE OF THE PRODUCT, RELATING TO WARRANTY SERVICE, OR ARISING OUT OF ANY
BREACH OF THIS LIMITED WARRANTY, EVEN IF D-LINK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
THE SOLE REMEDY FOR A BREACH OF THE FOREGOING LIMITED WARRANTY IS REPAIR, REPLACEMENT OR
REFUND OF THE DEFECTIVE OR NON-CONFORMING PRODUCT.  THE MAXIMUM LIABILITY OF D-LINK UNDER THIS
WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT COVERED BY THE WARRANTY. THE FOREGOING
EXPRESS WRITTEN WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ANY OTHER WARRANTIES
OR REMEDIES, EXPRESS, IMPLIED OR STATUTORY.

Governing Law:  This Limited Warranty shall be governed by the laws of the State of California. Some states do not allow
exclusion or limitation of incidental or consequential damages, or limitations on how long an implied warranty lasts, so the
foregoing limitations and exclusions may not apply. This Limited Warranty provides specific legal rights and you may also have
other rights which vary from state to state.

Trademarks:  D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered trademarks are the
property of their respective owners.

Copyright Statement:  No part of this publication or documentation accompanying this product may be reproduced in any form
or by any means or used to make any derivative such as translation, transformation, or adaptation without permission from D-
Link Corporation/D-Link Systems, Inc., as stipulated by the United States Copyright Act of 1976 and any amendments thereto.
Contents are subject to change without prior notice.  Copyright 2005 by D-Link Corporation/D-Link Systems, Inc. All rights
reserved.

CE Mark Warning:  This is a Class B product. In a domestic environment, this product may cause radio interference, in which
case the user may be required to take adequate measures.

FCC Statement:  This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:
· Reorient or relocate the receiving antenna.
· Increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
· Consult the dealer or an experienced radio/TV technician for help.
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FCC Caution:
The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to this equipment;
such modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

IMPORTANT NOTE:
FCC Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.  The antenna(s) used for
this equipment must be installed to provide a separation distance of at least eight inches (20 cm) from all persons.
This equipment must not be operated in conjunction with any other antenna.

Warranty

For detailed warranty information applicable to products purchased outside the United States, please
contact the corresponding local D-Link office.
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Registration

Registration

021605

Product registration is entirely voluntary and failure to complete or return
this form will not diminish your warranty rights.
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